
Page 1 
 

KARMA Motif 
Creating GEs with the Import To GE Editor 
Revision 07-Oct-2014 © by Stephen Kay 

 

Introduction 
 
This tutorial explains how to use KARMA Motif’s Import To GE Editor to create GEs from simple 
recorded MIDI Phrases, store them, and use them inside KARMA Motif. If you work through these four 
short examples (2 Drum Grooves, and 2 Melodic Phrases), you will gain an understanding of how all 
the parameters work. For a detailed explanation of each parameter, see the KARMA Help File > Import 
To GE Chapter. You will also learn a great deal about operating KARMA Motif in general! 
 
The editor presently allows you to import a phrase and turn in into a GE Type “Drum”, with either 
drum notes or melodic data, equally suitable for drum grooves or melodic phrases. While there are 
other types of GEs, this is the only one that is supported for importing from .MID files at this time. See 
the next page for a description of the GE Editor > Drum Page. 
 
To open the editor, select the Import To GE Editor button at the top of KARMA’s Main Application 
Window. The key concepts with this editor are: 
 
• It imports a .mid file and keeps the data in memory temporarily so you can repeatedly try different 

settings if you want. 
• It shows you some analysis data of the pattern, and shows how many rows will be used in each of 

the three Drum Pattern grids, and the “analysis” changes when you change settings - so you can 
optimize the results. 

 

www.karma-lab.com 
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Brief Explanation of the GE Editor > Drum Page 
 
Note that all of the following discussions about patterns, 7 notes per grid etc. relate to the fact that we 
are creating a GE Type “Generated-Drum”, with either drum notes or melodic data. The three patterns 
and pattern grids discussed here appear in the Generated Effect Editor > Drum Page: 

 
As shown above, in a typical Drum GE (RTC Model Type DP1 – Drum/Perc), there are three Drum 
Pattern grids, each capable of holding seven notes and a rest marker (bottom orange row). Usually, 
kick/snare/toms are on Pattern 1, cymbals and hi-hats are on Pattern 2, and percussion and other 
noises are on Pattern 3. In Melodic Drum GEs (RTC Model Type DM1 – Drum Melodic), notes are spread 
across the three grids, such that the patterns can be activated individually or together and create 
different combinations of notes. 
 
Note: to avoid potential confusion, it’s worthwhile to note that the note numbers displayed on the rows of 
the patterns may not always be what is generated, due to the use of the Note Map feature which can remap 
any output note to any other output note. It is common in many Performances for the Drum GEs to be 
running through a Note Map in order to change certain drum notes into other ones, or a melodic Drum GE 
to be running through a Note Map in order to remap certain scale tones. 
 
In the following examples, we will discuss various ways of controlling which notes end up on which 
pattern grids. Don’t worry if you don’t understand all of the technical jargon in some of the 
descriptions of GE parameters – you can perform these operations without knowing all about the 
internal workings of a KARMA GE, and later some of these descriptions will make more sense. 
 
Note: the use of “Motif” in this document refers to all of the supported Yamaha devices: Motif XS, Motif XF, 
MOX, MOXF, Rack-XS and S70/S90 XS. The tutorial works the same for all of them. Occasionally, where 
necessary a clarification will be made for the Rack-XS or S70/S90 XS (which have a Multi Mode instead of a 
Song Mode).  
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Example 1 (Drums) 
 
1. Launch KARMA Motif Software, with the default Factory KDF file.  
 
2. Select the Performance “Import To 

GE (Drums)”. You can do this in one 
of two ways: 

 
A. From the KDF contents area, 

double-click the second 
Performance Bank, “2 Tutorials 
& Examples”). The Bank 
Display Page opens for that 
bank, and you can select “1 
Import To GE (Drums)”. 

 
 
 

B. From the Performance Editor, 
you can use the drop-down 
menus to select the second 
bank, and the “1 Import To GE 
(Drums)” Performance.  

 
 
 
 
 
 
3. This will automatically load one of the Motif Songs – and you should be in the Motif’s Song Mode 

(for the Rack-XS or S70/S90 XS, it will select a Multi in the Multi Mode). Verify that it plays a drum 
groove, i.e. by playing some notes on the keyboard, or playing Chord Trigger 1 from an attached 
computer keyboard with Function Key [F1]. You can also use the mouse, of course, and click on 
Chord Trigger 1 in the Real-Time Controls Editor.  

 
4. To stop playback, use the Stop button in the Main 

Window’s upper left Toolbar, or the Return key of the 
computer keyboard. 
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5. From the Window Menu, select the Import To GE Editor (Mac cmnd+E, Win ctrl+E) and the editor 
is displayed (you can also use the Import To GE button at the top of the Main Window). At first, it 
will say (in the Analysis Area): 

 
*** NO DATA LOADED *** 
Use the [Select New File] button. 

 
6. Click the [Select New File] button at the bottom, and locate the example files included with this 

tutorial. There is a folder named “Tutorial Files” containing several .MID files located in the 
application’s Tutorials Folder, which you can open and bring to the front using the “Tutorials 
Folder” command on KARMA’s Help Menu. For reference, the location of the folder is: 

 
Mac OS X:     ~/Applications/KARMA Motif/Tutorials/Tutorial Files 
Windows XP:   C:\Program Files\KARMA Motif\Tutorials\Tutorial Files 
Windows 8, 7, Vista:  C:\Users\Your Account\Documents\KARMA Motif\Tutorials\Tutorial Files 
 
Load the .mid file named: “Drum Groove 1.mid”. 

 
7. After doing so, the pattern’s analysis will appear in the Analysis Area. There is a button at the 

bottom named [Play Original] – it will play the imported data that is in memory, so you can hear 
the full original pattern. It’s not exact, as it is quantized to 24 cpq, not the original pattern’s 
resolution, but it gives you an idea of what the pattern sounds like, if there’s a fill at the end, etc. 

 
Let's examine the Analysis Area as to what it tells us: 
 

File Name: Drum Groove 1.mid,   1314 Bytes 
-------------------------------------------------- 
SMF Format 0, Number of Tracks 1, Resolution 480 
Tempo 120.00, Time Sig 4/4, Last Event 5.1.000 
Expected number of steps 64 

 
First, you see the name of the pattern currently imported, and some info about it. The most important 
thing at the moment is the "Last Event" - this shows that the pattern is a 4 bar phrase. Sometimes this 
will have an extra note on the ending downbeat, i.e. 5.1.000; sometimes a pattern will show 4.4.360 or 
something like that. It's still considered a 4 bar phrase. 
 

================================================================= 
row  note  drum sound  velLev times loVel  hiVel  avgVel rowVel 
--[Pattern 1 - Drums]------------------------------------[   0]-- 
 6   40 E_1 - Snare 2   [2]     2     64     64     64     -56 
 5   40 E_1 - Snare 2   [0]     2    120    120    120       0 
 4   38 D_1 - Snare 1   [2]     3     64     64     64     -56 
 3   38 D_1 - Snare 1   [0]     6    120    120    120       0 
 2   36 C_1 - Kick 1    [1]     6    102    108    103     -17 
 1   36 C_1 - Kick 1    [0]    12    120    120    120       0 
--[Pattern 2 - Cymbals]----------------------------------[ -20]-- 
 3   46 A#1 - HH Open   [1]     4    100    100    100       0 
 2   42 F#1 - HH Closed [2]    32     66     74     66     -34 
 1   42 F#1 - HH Closed [1]    12     96    108    100       0 
 

The above shows us the notes that will be split into the first two patterns, based on the settings of the 
"Split into Patterns" and "Split Into Rows" sections. It shows which row in each pattern the notes will 
go to, and some other things: 
 
note - the MIDI note number of the row. 
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drum sound - the drum sound related to that note, based on the modified GM map used for Motif 
drum GEs. 
 
velLev - when a note is split into up to three rows by velocity, it shows which level of the three 
available levels the row corresponds to, where velLev[0] are the loudest notes, velLev[1] are the mid 
level notes, and velLev[2] are the softest notes. 
 
times - shows how many notes will be in that row (across the pattern).  
 
loVel - the lowest velocity note that will be included in that row. 
hiVel - the highest velocity note that will be included in that row. 
These two pieces of information can be used to "optimize" the split by velocity threshold settings and 
arrive at better approximations. 
 
avgVel - this shows the average velocity of all notes in that row, which is how they will be played by 
KARMA. 
 
rowVel - shows what the resulting Row Velocity Offset will be. The number at the top in each pattern’s 
name row in brackets (i.e. [-3]) is the overall Pattern Velocity Offset. If the “Optimize Velocity Offsets” 
checkbox is Off, this value will be [   0] and the Row Velocity Offsets will show the exact calculated 
settings for each row; if “Optimize Velocity Offsets” is On, the value may be negative and the Row 
Velocity Offsets will be increased by that amount, so that at least one row is at 0, and one Pattern is at 
0. (All Row Offsets will be raised to be as close to zero as possible, while maintaining the relative 
distance between each row in each Pattern. See the Parameter Reference for more info on this 
setting.) 
 
Continuing: 
 

--[Pattern 3 - Perc]-------------------------------------[  -3]-- 
11   81 A_4 - Open Trian[1]     4     90     90     90     -27 * 
10   80 G#4 - Mute Trian[1]    18     90     95     90     -27 * 
 9   64 E_3 - Low Conga [2]     2     51     74     62     -55 * 
 8   64 E_3 - Low Conga [1]     8     76     99     86     -31 * 
 7   64 E_3 - Low Conga [0]     1    111    111    111      -6 
 6   63 D#3 - Open High [2]     2     46     72     59     -58 
 5   63 D#3 - Open High [1]     4     78     82     80     -37 
 4   62 D_3 - Mute High [2]     2     68     68     68     -49 
 3   62 D_3 - Mute High [1]     4     78    105     89     -28 
 2   62 D_3 - Mute High [0]     2    117    117    117       0 
 1   54 F#2 – Tambourine [1]    28     87    110     90     -27 
--[Summary]------------------------------------------------------ 
Pat 1, rows required = 6 
Pat 2, rows required = 3 
* Pat 3, rows required = 11, 4 notes will be skipped 
** Total Rows Required = 20, 4 notes skipped 

 
Above is the info for Pattern 3, and a “Summary” section – the various red rows show us that there are 
just too many percussion notes to import into seven rows. All of the red * rows would be ignored. 
However, this is where you say "OK, now how can I optimize the settings to get the whole pattern?" 
 
8. The answer is: Turn OFF the checkbox for Pattern 3 under “Split 

Into Rows”. Now, instead of each note taking multiple rows at 
different velocity levels (for the third pattern), each note gets a 
single row and they are all able to fit. The Analysis Area updates 
to show the new prediction, and all of the red lines disappear. 
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9. So, now that the data is adjusted, choose a location to store 
the GE, using the Bank and GE menus at the bottom left. You 
may wish to create a new User GE bank first (Main Window > 
Menu Button (the KMO icon) > Add Banks), or you can store it 
in one of the empty GE locations in the included empty GE 
User Bank. This example uses the location 13 GE Bank – User 
(which it will be set to by default – it uses the first empty 
location in the first unlocked GE Bank.)  

 
10. Press the [Execute] button at the bottom right to create the GE. You will see the GE Name in the 

popup menu change to “Drum Groove 1.mid” as the GE is stored in the selected location. Select 
the Generated Effect Editor > Drum Page (also referred to as the GE Editor > Drum Page), and 
you can view the imported data. The correct RTC Model has been automatically been applied to 
the GE (meaning that Module Control Layer 1’s switches and sliders have been assigned to provide 
instant variations on the groove). You can open the Real-Time Control Editor’s RTC View (Mac 
cmnd+L, Win ctrl+L) and immediately start playing with the RTC Model, the same as with other 
factory-programmed GEs. Try adding Repeat Repetitions with Slider 7, arpeggiated bend with 
Switches 5 & 6, simplifying the groove with Slider 3 Note Randomize, etc. Use one of the Chord 
Trigger buttons in the Real-Time Control Editor to trigger the groove – or play a note on the 
keyboard. 

 
11. Note that the “Create Velocity Pattern” checkbox is on by default (in the Import To GE Editor), 

along with the first pattern selected. What this does is attempt to use the difference between how 
the notes are played in the actual sequence data, and how KARMA will generate them, to create a 
Velocity Pattern that will then be applied to the selected pattern, to try to get more velocity 
nuances. You can see the result in the GE Editor > Velocity Page. The kicks and snares in the .MID 
file do not have a lot of velocity variation, so the resulting pattern is mostly a straight line. 
However, try turning off the “1: 
Drums” checkbox and turning 
on the “3: Perc” checkbox 
instead, and pressing [Execute] 
again. Then view the resulting 
Velocity Pattern – it has much 
more variation in it because the 
percussion rows have wider 
velocity fluctuations, as can be 
seen in the analysis area, by 
looking at the loVel and hiVel 
columns: 

 
row  note  drum sound  velLev times loVel hiVel avgVel rowVel 
--[Pattern 3 - Perc]-------------------------------------[ -30]-- 
 6   81 A_4 - Open Trian[0]     4     90     90     90       0 
 5   80 G#4 - Mute Trian[0]    18     90     95     90       0 
 4   64 E_3 - Low Conga [0]    11     51    111     84      -6 
 3   63 D#3 - Open High [0]     6     46     82     73     -17 
 2   62 D_3 - Mute High [0]     8     68    117     90       0 
 1   54 F#2 - Tambourine [0]    28     87    110     90       0 
 

12. Note that each time you press [Execute], it “recreates” the GE in the 
same location, overwriting the previous one (unless you choose a new 
location) – this allows you to fine-tune your settings by trying different 
options. You will also see this warning dialog, which tells you that the 
current Performance has been edited. See the “Saving your work” 
section for more information – you can dismiss this for now (answer OK 
to perform the Import, or Cancel to leave the Performance as it is).  
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Example 2 (Drums with fill) 
 
Here, we will deal with importing an 8 bar loop that has a fill at the end. Normally, since there is a 
maximum of 64 steps in the drum patterns depending on the default settings, it would only get the 
first 4 bars and you would not be able to get the fill. But you can tell it to skip the middle of the pattern 
and take the beginning and the end fill, and automatically set the GE’s Phase Pattern to make it into an 
8 bar phrase, similar to what it really is. 
 
1. Go back to the Import To GE Editor if you are not already there, click the [Select New File] button, 

and load the one named “Drum Groove 2.mid”. Let’s look at the Analysis Area: 
 

File Name: Drum Groove 2.mid,   1372 Bytes 
-------------------------------------------------- 
MF Format 0, Number of Tracks 1, Resolution 480 
Tempo 120.00, Time Sig 4/4, Last Event 8.4.360 
Expected number of steps 128 

 
The important thing to notice here is that the “Last Event” is 8.4.360 – this tells us that this is an 8 bar 
drum loop (1.1.000 ~ 9.1.000). Of course, we can hear that using the [Play Original] button as well. 
Furthermore, we can see that the “expected number of steps (128)” would be way over the 64 steps of 
the pattern. Therefore, if we import it now, we would lose the second half of the pattern and the fill. 
 
2. Change the “Import Bars” parameter to “1 x - - x”. This tells it 

that we will import the first 2 bars, and the last 2 bars, 
thereby getting the fill. Note that the Analysis Area changes 
now, because more drum notes (a tom fill) are included in 
the final pattern. In addition, the “expected number of 
steps” at the top changes to 64. 

 
3. Notice that the “Phase Pattern” parameter is set to “3 x---x---

x---x---“ by default. (The ‘x’ marks indicate where, an a 16 
bar phase pattern, the drum pattern will be restarted, with 
the dashes indicating a step with no restart.) This setting 
allows the full pattern on the grid (which is 4 bars long by 
default) to be played through each time. For this example, 
set it to “2 x-x-x---x-x-x---“, which tells it to set the Phase 
Pattern Drum “pr” buttons (pattern restart) so that the first 2 bars of the pattern are played 3 times, 
followed by the last 2 bars, giving us an 8 bar phrase with a fill at the end. In other words, the 
pattern is restarted 3 times in a row such that you only hear the first two bars of it three times 
followed by the fill, when it is allowed to play all the way through. If that doesn’t make sense, don’t 
worry – we’ll look at this visually in just a moment. Continuing with the Analysis Area: 

 
row  note  drum sound  velLev times loVel  hiVel  avgVel rowVel 
--[Pattern 1 - Drums]------------------------------------[   0]-- 
 8   48 C_2 - Hi Tom 2  [1]     1     95     95     95     -25 * 
 7   47 B_1 - Mid Tom 1 [1]     1     97     97     97     -23 
 6   45 A_1 - Mid Tom 2 [0]     1    120    120    120       0 
 5   43 G_1 - Lo Tom 1  [2]     1     73     73     73     -47 
 4   43 G_1 - Lo Tom 1  [0]     1    120    120    120       0 
 3   38 D_1 - Snare 1   [0]     7    120    121    120       0 
 2   36 C_1 - Kick 1    [1]     2    103    108    105     -15 
 1   36 C_1 - Kick 1    [0]    11    116    124    119      -1 
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4. Notice that there is one too many notes in Pattern 1 (one of the toms). However, by looking at the 
velocity information, I can guess that something could be combined without completely 
removing the velocity to the rows like we did in the last example – as you gain more experience 
with this feature, you’ll be able to guess as well! So in the “Split into Rows” section, change the 
“Velocity Threshold (lo/hi)” for Pat 1: Drums to 76/125 – you will get the kick down to one row, and 
now the other row fits. (Click in the number box and type in 
125 followed by Enter.) 

 
5. Turn back ON the checkbox for “Pattern 3 Percussion” 

under Split Velocities by rows (if off from the previous 
example). Pattern 3 expands to seven rows. 

 
6. Press [Execute] – notice that you will get a warning dialog 

since the Performance is edited from the previous example 
and try it out, again triggering the groove in one of the previously discussed ways. Notice that the 
fill happens in the eighth bar, like the original pattern, because of the settings we made. In the GE 
Editor > Drum Page, watch the LED tracking arrays under each drum pattern, and see how they 
restart 3 times before continuing through the end of the pattern to play the fill. Check out the 
Phase Page of the GE Editor, as to how the yellow “pr” (Pattern Restart) buttons are set in the 
three Drum Pattern areas – this causes the restarting behavior. 

 

 
Important note: These two drum examples used phrases that were 
specifically created for the KARMA “Motif (Yamaha)” Drum Map, 
which is basically a slightly modified GM2 Drum Map. All of the GEs 
and Performances included with KARMA Motif use this drum 
mapping. You should always import drum grooves that use this 
mapping, or edit them first to use this mapping; otherwise, the 
“Split Into Patterns” feature cannot guess which patterns to put the 
correct drum sounds on. There is an additional mapping supplied 
for importing drum grooves created on a Korg keyboard such as 
the M3, M50, Karma, Triton or OASYS, which is basically a GM map raised by an octave. This can be selected 
with the “Drum Map” parameter. 
 
Another document (located in the Performance Notes) provides more details on the KARMA Motif Drum 
Map. 
 
 
Example 3 (Melodic Data – Bass Line) 
 
 Here we will import a very simple melodic phrase comprised of 
seven or less pitches. 
 
1. Select the Performance “2 Import To GE (Bass)” from the 

Bank Display Editor. This will automatically load one of the 
Motif Songs (or Multis on the Rack-XS and S70/S90 XS) – 
verify that it plays a bass line by triggering Chord Trigger 1 
or playing the keyboard. 
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2. Note: the reason it is playing a bass 
line and not a Drum Groove from 
the Motif Song is the fact that the 
MIDI Output Channel for Module 1 
has been set to Channel 5, not 
Channel 4 in the Performance 
Editor > MIDI Setup Page. 

 
3. Select the Import To GE Editor if it is not already showing using the button at the top of the Main 

Application Window. You can also use the “Windows” Menu, or cmnd+E (Mac) or ctrl+E (Win) from 
the computer keyboard. 

 
4. IMPORTANT: Change the “Interpretation” popup to “Melodic 

Data”. This tells it that we are creating a melodic phrase that 
we want to track around the keyboard and follow chord 
changes, not a fixed drum groove that doesn’t transpose. In 
addition, this influences how things are displayed in the 
Analysis Area, and how some of the other parameters function. 

 
The settings are automatically restored to the default settings for a Melodic Drum GE. Note that 
you can also press the [Default Settings] button near the bottom at any time to restore the proper 
initial settings for a Drum GE vs. a Melodic Drum GE. 

 
5. Use the [Select New File] button to locate and select the file named “Bass Line.mid”. Press the [Play 

Original] button to hear the phrase on the current Motif Song/Multi. Notice that the phrase has 
been written in the key of Cmaj7, even though it was originally a min7 phrase. This is an important 
point – if you want the data to make sense and track chord changes on the keyboard, you need to 
write or transpose the phrase to Cmaj7 before importing – even if it sounds bad. It will sound good 
when you play chords on the keyboard later. 

 
6. Let’s take a look at the Analysis Area: 
 

File Name: Bass Line.mid,   241 Bytes 
-------------------------------------------------- 
SMF Format 0, Number of Tracks 1, Resolution 480 
Tempo 120.00, Time Sig 4/4, Last Event 3.1.000 
Expected number of steps 32 
 
================================================================= 
row    note    velLev times  loVel  hiVel  avgVel  rowVel 
--[Pattern 1]--------------------------------------[   0]-------- 
 5    43  G_1   [0]     2      93    105     99      -10 
 4    41  F_1   [0]     2     105    114    109        0 
 3    40  E_1   [0]     2     105    111    108       -1 
 2    36  C_1   [0]     5     108    114    109        0 
 1    35  B_0   [0]     2     105    114    109        0 
--[Pattern 2]---------------------------------------------------- 
--[Pattern 3]---------------------------------------------------- 
--[Summary]------------------------------------------------------ 
Pat 1, rows required = 5 
Pat 2, rows required = 0 
Pat 3, rows required = 0 
Total Rows Required = 5 
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As we can see, this is a 2 bar pattern (ending on 3.1.000) and there are five notes in the original 
pattern. Let’s try to get up to seven, just to fill the first grid at least, and get a bit more velocity 
nuance. 

 
7. Turn on the “Split Into 3 Rows by Velocity” checkbox. Now the Analysis Area shows that it jumps 

up to nine notes, and spills over onto the second pattern. However, we don’t really want to do 
that; having two notes on the second grid will not work well for turning on and off the three 
patterns from the Real-Time Controls Editor, which is one of the features of the RTC Model for this 
GE Type. It will be better to try and get as many rows as possible in the first pattern, leave the 
others empty (and the RTC Model algorithm will fill them with a variation of the first pattern when 
we create the GE.) 

 
8. Start lowering the “Threshold hi” value – click in the number 

box and drag with the mouse or use the up/down arrow keys 
of the computer keyboard. As you hit ”105”, it jumps from 8 
notes down to 6, which is the best we can do. 

 
9. Press the Execute button and examine the results in the GE Editor, and play with it on the 

keyboard, trying out different chords. Play a minor 7 chord and listen to the results – this was 
actually the original phrase (before we edited it to play a maj7). The correct RTC Model has already 
been applied to it, and everything is set up to produce useful results in the Real-Time Control 
Editor. Try adding Repetitions (Slider 7), while turning Force Mono on (Switch 1) and changing the 
note patterns with Repeat Transpose (Slider 8). Try adding in the other two patterns (Switches 3 
and 4) - which are system-generated variations of the first one, since only one pattern was filled, 
try making the repeated notes louder with Switch 8, turning on bend settings with Switch 5, play 
with bend variations with Switches 6 and 7, etc. A polyphonic bass program was purposely chosen 
to more easily demonstrate the function of the Force Mono button – you will want this on most of 
the time for bass lines. Nevertheless, try it with some monophonic bass programs later – you will 
get some interesting results with it in either position. 

 
10. Notice that, since the 

“Create Duration Pattern” 
button was checked by 
default, a Duration Pattern 
has been created to simulate the durations of the original 
phrase – you can view this in the GE Editor > Duration Page. 
Play with the Duration Slider 3 in the Real-Time Control Editor 
to adjust and vary the durations of the notes.  

 
 
 
11. Also note that the “Create Velocity Pattern” button was checked 

by default, and has created a Velocity Pattern that is applied to 
the notes. If you feel that this feature is not helping your 
specific GE (i.e. too much Velocity change to the notes) you can 
disabled it while creating the GE.  
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Example 4 (Melodic Data - Riff) 
 
Here we will import a slightly more complex melodic phrase that needs to span two patterns. 
 
1. Similar to the last example, select the Performance “3 

Import To GE (Riff)” from the Bank Display Editor. A 
corresponding Motif Song/Multi we’ve chosen should 
automatically load - verify that it plays a simple up/down 
arpeggio by triggering Chord Trigger 1 or playing the 
keyboard. A very simple polyphonic synthesizer sound was 
chosen to demonstrate this one. 

 
2. Return to the Import To GE Editor, press the [Select New 

File] button and locate the file named “Melodic.mid.” Try it 
out with the [Play Original] button (note again that the riff is 
in Cmaj7 tonality.) 

 
3. Press the [Default Settings] button to return to the default 

settings for Melodic Data. Let’s take a look at the Analysis 
Area: 

 
File Name: Melodic.mid,   444 Bytes 
-------------------------------------------------- 
SMF Format 0, Number of Tracks 1, Resolution 480 
Tempo 120.00, Time Sig 4/4, Last Event 2.4.360 
Expected number of steps 32 
================================================================= 
row    note    velLev times  loVel  hiVel  avgVel  rowVel 
--[Pattern 1]--------------------------------------[   0]-------- 
 7    64  E_3   [0]     3      90     93     92      -23 
 6    62  D_3   [0]     1     102    102    102      -13 
 5    60  C_3   [0]     2     105    105    105      -10 
 4    59  B_2   [0]     1      99     99     99      -16 
 3    55  G_2   [0]     2     111    111    111       -4 
 2    52  E_2   [0]     2     105    114    109       -6 
 1    48  C_2   [0]     2     114    117    115        0 
--[Pattern 2]--------------------------------------[ -13]-------- 
 1    67  G_3   [0]     2     102    102    102        0 

 
Here, we can see that the imported data requires eight notes. Since it’s not a good idea to leave it with 
just one note on a grid, let’s split the notes between two patterns. (Why? This will not be useful when 
turning the individual patterns on and off in the Real-Time Control Editor later.) 
 
4. Turn on the “Split Notes into 3 Patterns” checkbox. This 

allows two split points for MIDI note values to be used to 
separate the notes onto the three grids. In this case, the 
default split settings seem to work well, as we’ve now got 4 
notes on each of the first two grids: 
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row    note    velLev times  loVel  hiVel  avgVel  rowVel 
--[Pattern 1 - Low]--------------------------------[   0]-------- 
 4    59  B_2   [0]     1      99     99     99      -16 
 3    55  G_2   [0]     2     111    111    111       -4 
 2    52  E_2   [0]     2     105    114    109       -6 
 1    48  C_2   [0]     2     114    117    115        0 
--[Pattern 2 - Mid]--------------------------------[ -10]-------- 
 4    67  G_3   [0]     2     102    102    102       -3 
 3    64  E_3   [0]     3      90     93     92      -13 
 2    62  D_3   [0]     1     102    102    102       -3 
 1    60  C_3   [0]     2     105    105    105        0 

 
5. Press [Execute] and check the results in the GE Editor and by playing it. Try turning on and off 

Patterns 1 and 2 in the Real-Time Controls Editor (Switches 2 and 3). It works pretty well, but I can 
see that it might be better if the top note (row #4) of Pattern 1 was actually part of Pattern 2 
instead. 

 
6.  Go back to the Import To GE Editor, and change the first 

split point from B2 down one semitone to A#2. As you can 
see in the Analysis Area, we’ve taken the top note off 
Pattern 1 and moved it to Pattern 2. Press [Execute] again 
and check the results – yes, this will be much better when 
trying to use the two patterns separately. You can also check out the variation on Pattern 3 (Switch 
4 in the Real-Time Controls Editor) that the system has created based on moving around the 
notes of Pattern 1. This can be combined with the others to increase the activity.  

 
7. Not to wander too far, but you could go into Pattern 3 (by clicking on the Note Names next to the 

Pattern 3 grid in the GE Editor > Drum Page) and set the Pattern Transpose parameter to +24 for 
additional pitch variation (try this with all three Patterns running). 

 
8. We could go a bit further and try to use some of the 

additional rows in those two patterns for additional velocity 
nuances. Turn on the “Split Into 3 Rows by Velocity” checkbox 
– this time we’ve got a separate threshold for each pattern, 
because we have the “Split Notes into 3 Patterns” checkbox 
above this section turned on. By experimenting, it seems that 
setting Pat1 to 106/117 and Pat 2 to 93/111 produces the 
maximum number of rows from this data. 
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9. Once again, experiment with the Real-Time Controls Editor settings to see all of the many 
interesting variations you can come up with just by moving sliders and changing switches. In 
addition, remember that all of this can be stored in a scene for instant recall of variations! 

 
 

Initializing a Performance 
 
When you press the [Execute] button in the Import To GE Editor, it creates a new GE in the location 
you specify at the bottom of the window. However, the GE is installed into Module 1 of the current 
selected Performance in the Edit Buffer. In other words, if you presently have a multi-module Factory 
Performance selected, and you [Execute], it installs the GE inside Module 1, so that you can audition it 
and work with it.  
 
However, given that the multi-module Factory Performances often have specific programming already 
set up that may be confusing to use with a new GE you are simply trying to import, you may wish start 
with an initialized Performance. 
 
In order to make this tutorial easier to follow, the Tutorial Performances we have been using were 
provided, already set up. Nevertheless, it’s useful to know how to initialize a Performance yourself, 
with one of several different Module setups. 
 
Note that the Factory Bank of Performances has 64 fully programmed 6-module Performances with 
corresponding Motif Songs (Multis for the Rack-XS and S70/S90 XS). The other locations that have no 
names are initialized single-module Performances (see the description below for 1 Module) that you 
can easily choose to begin working with, if you so desire. 
 
However, the software provides several different ways of initializing a Performance to one of several 
different setups, so that you can experiment with creating your own Performances or use the Import 
To GE Editor with them. First, you can initialize the currently loaded Performance. 
 
 
 
1. When you have a Performance loaded (the “Current 

Performance”), you can initialize it (in the Edit Buffer) by 
using the “Initialize Current Performance...” command 
from the Menu Button in the Performance Editor. 

 
 
 
 
 
 
 
2. This opens the Initialize Current Performance Dialog. You can 

choose from 15 different RTC Model types to specify how the GE in 
Module 1 will be initialized. Note that a discussion of RTC Models is 
beyond the scope of this document. For the purposes of importing 
.MID files as discussed here, it doesn’t matter what you set it to 
since importing the GE will replace it with either a “DP1 – 
Drum/Perc” type (for drum grooves) or a “DM1 – Drum Melodic” 
type (for melodic phrases). Therefore, you can just leave it set to 
the default option, which is a general arpeggio type. 
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3. The important setting to discuss here is the “Module Setup Type” – there are three options: 
 

1 Module 
Initializes a single-module Performance, such as the ones we have been using in this tutorial, 
with the other Modules disabled, the Keyboard Layers muted, and the Control Layer set to 
Module 1. This is the easiest setting to use for trying to experiment with KARMA GEs, and for 
importing phrases. 
 
6 Module 
Initializes a multi-module Performance with all six Modules and both Keyboard Layers enabled 
and set to default settings, but only the Run button turned on for the first Module. 
 
6 Module, Standard Controllers 
Initializes a multi-module Performance with all six Modules and both Keyboard Layers enabled 
and set to default settings, but only the Run button turned on for the first Module (the same as 
the previous option). Additionally, this sets up additional parameters such as the 
Performance > Dynamic MIDI Page to have the usual factory program style controller 
parameters hooked up, such as Stutter, Retrigger and Fill. It also sets up Module 6 to be 
controlled as a Fill Module, even though it is still a default arpeggio at this time. This might be 
the best choice if you wish to start programming your own Performance in the style of the 
Factory Performances (but it does require that you know a bit more.) 

 
4. After choosing one of these and pressing the OK button (green checkmark), the current 

Performance will be initialized in the Edit Buffer. At this point, you can do what you like with it, 
including using the Import To GE Editor. However, since it is only in the Edit Buffer, you will need 
to save your work once you are happy with it as detailed in the next section. 

 
Second, you can initialize multiple Performances (or an entire bank of Performances) from the Bank 
Display Editor of the Main Application Window. 
 
 
1. Select one or more Performances in a Performance 

Bank, using shift-click for individual Performances, or 
shift-cmnd-click (Mac), shift-ctrl-click (Win) for 
ranges. Choose the “Initialize Selected 
Performances...” command from the Menu Button. 

 
2. Alternately, you could choose the “Initialize This 

Bank...” command. 
 
 
 
3. The dialog that is displayed does not contain the option to select 

an RTC Model Type for the GE, as they are all initialized to use GE 1: 
Arp Model 01 Up/Down. You can still select from the three types of 
Module Setups discussed above.  

 
4. After pressing the OK button (green checkmark), all specified 

Performances will be initialized with the option you chose. 
 
 
Note: When you add a new bank of Performances to the KDF file using the Main Application Window Menu 
Button (the KARMA Motif Logo button), they are all initialized to the single-module option by default. 
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Saving your work 
 
As mentioned previously, when you press the [Execute] button in the Import To GE Editor, it creates a 
new GE in the location you specify at the bottom of the window. The GE is saved into the current KDF 
file; however, the KDF still needs to be saved if you want to keep this. However, what about the edited 
Performance, that holds the GE (along with five others, the Keyboard Layers and all other related 
parameters)?  
 
The GE created by the Import To GE Editor 
is installed into Module 1 of the current 
Performance in the Edit Buffer. If you want 
to edit the Performance aspects, you can, 
such as key zones, triggering options and 
other settings in the Performance Editor. 
However, you then need to store that 
Performance somewhere, if you want to 
keep what you’ve done. You do this using 
the [Save] button at the top of the 
Performance Editor, next to the Bank and 
PE popup menus.  
 
 
In the resulting dialog, you can rename the Performance, give it a 
colored label if desired, overwrite the current location, or choose a 
different location.  
 
 
 
 
 
You can also use the “Save Performance” button in the Main 
Application Window’s Toolbar in order to avoid a trip to the 
Performance Editor. This brings up the same dialog. 
 
 
 
This saves the Performance that references your 
newly imported GE into the current KDF file. If you 
want to edit the GE further after it has been 
imported, or rename it, you similarly use the [Save] 
button at the top of the Generated Effect (GE) 
Editor to save the changes, next to the Bank and GE 
popup menus.  
 
 
 
A similar dialog is presented with options for storing and renaming 
the GE. 
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Both of these actions save your work into the current KARMA Data 
File (KDF file), but this is only in RAM – you still need to save the KDF 
to your computer’s hard disk, like saving a text document that has 
been worked on. From the File Menu, use either “Save” to update 
the current file or “Save As” to create a new file (and leave the 
original as it was). These commands are also located on the Main 
Application Window’s Toolbar.  
 
When working on a GE within a Performance, the recommended sequence of saving your work goes 
like this: 

1. Save the GEs that are part of the Performance, if they have been edited. 
2. Save the Performance. 
3. Save the KDF file. 

 
Note that an edited Performance or GE will display a diamond (Mac) or asterisk (Windows) to the left of the 
name wherever it is displayed, indicating it has some unsaved changes – as shown in several of the above 
examples. 
 
You may also see this warning dialog when pressing [Execute], 
which tells you that the current Performance has been edited. 
Answer OK to perform the Import, or Cancel to leave the 
Performance as it is (in case you want to save the changes 
somewhere). If you do not want to see this anymore for the rest of 
the session, turn on the checkbox before closing the dialog. 
 
 
Tips for creating Melodic Drum GEs 
 
Phrases that are being imported should be in the key and tonality of Cmaj7, if you want them to be 
able to follow different chord types and keys like you typically might expect from backing track 
software and arranger styles. KARMA uses NTT (Note Transposition Tables) to map the notes to 
different chords, and this works best when the notes have the elements of a Cmaj7 chord. In other 
words, let’s say you have a minor phrase in mind. Record the phrase, but then, before importing it, 
change it to Cmaj7. Many external programs have some sort of scale transposition features that can 
automate this, but if not, the idea is that all notes of a minor 3rd (Eb in the key of C) would be changed 
to a major 3rd (E), all dom7 or min7 (Bb) to a maj7 (B), etc. This can make the phrase sound weird, but 
after you import it, it will follow chord changes because KARMA does this in reverse. 
 
If you simply want a completely fixed phrase that changes keys, but does not shift any of the notes to 
other tonalities (for example, staying minor no matter what chord you play), it should still be in the key 
of C when being imported. Then, in the resulting GE, turn off the NTT buttons on each of the three 
Drum Patterns. This will follow the root note around, but will stay in a fixed chord. 
 
When importing simple phrases, you want to optimize the settings in the window for good results. If 
there are eight notes in the riff, you don't want seven of them on one pattern, and a single note on the 
second pattern. This will be useless for turning the individual patterns on and off in the scenes. Rather, 
change the Note Split point in the Import To GE Editor so that some notes end up on one pattern, and 
some on the other. 
 
At that point, or alternately, you can also use the “Split By Velocities Into 3 Rows” feature, to get more 
notes and more velocity levels. For example, if you already have to use two patterns, you might as well 
try to get seven notes or so in each pattern out of the phrase. 
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When you only create one or two patterns from the input data, the system creates a variation on the 
original pattern for the empty grids, but turns them off by default. In the RTC Model, they can be 
activated to provide variations and additional activity. Note that you can turn on Force Mono, and 
then turn on 2 or 3 patterns at the same time, and only get one note at a particular moment - they will 
fill in the spaces in each other and sometimes create interesting variations of the original. 
 
It’s generally not necessary to worry about Duration Patterns when creating a drum GE, so this option 
is off by default for the Drum Interpretation. (One possible exception would be if using a kit that has 
“hold” turned of so that the durations of the notes are gating it. In this case, you might want to create 
a Duration Pattern.) 
 
Finally, the way that the Note Transposition 
Tables shift around the notes to other chords 
can be varied by changing the “NTT Table” 
parameter at the top of the GE Editor > 
Drum Page. This parameter is only available 
for Melodic Drum GEs having at least one 
Pattern’s NTT button turned on, and selects 
from four different table types. Generally, the 
Chordal variations stick more to the notes of the chord and less to the passing tones, while the Scalic 
variations allow more passing tones. Refer to the Help Reference Guide for more info on these options, 
but generally, you can just try them out and play different chords until you find the one you like the 
most. 
 
If you’ve made it this far, congratulations! You’re well on your way to being able to create your own 
GEs and get the phrases you want into your own KARMA Performances. 
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